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Brief Description
The Get Backup application allows you to back up ﬁles and folders in the original or compressed format, and
then restore them back. Use of the program does not require special computer skills.
You can run tasks manually or automatically according to the schedule.
In addition to the backup functionality, the program allows you to synchronize the content of duplicate folders
keeping the most recent versions of ﬁles. Also you can create a bootable clone of a volume of a local or
external drive.
System Requirements
The program requires macOS 10.10 or higher.
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Why the Creation of Data Backups is Important
A backup is an additional copy of computer data that can be used to restore the original after a data loss.
The data loss can be caused by a computer malfunction, natural disaster, user's mistake or other causes.
You never know beforehand when this may happen. To protect your data, you should create backup copies
of your ﬁles.
Which ﬁles are worth backing up? Think about the documents that you have created. Probably the only copy
in the world is on your hard drive. Such a document is a candidate for inclusion in a backup. It is advisable to
create a backup copy of your mail. You can also save the information related to your user account (in case
you have to re-install the operating system).
You shouldn't backup programs, clip arts and other computer data if you have it on installation discs. Also
there is not much sense it backing up relatively small ﬁles or installation packages if they are available for free
in the Internet.
Note that if you backup conﬁdential information, you should make sure you keep the backup archives in a
safe place.
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Diﬀerent Approaches to Backups
Get Backup consists of several tools which let you back up your ﬁles in diﬀerent ways. You can create a
backup, archived backup, clone a hard disk or sync the content of a pair of folders.
A backup is a way to place copies of ﬁles in another location preserving the original formats of these ﬁles.
This is useful if you need to quickly access individual ﬁles in the backup. What is more, you can do this in
Finder without using Get Backup. Encrypted backups are possible if you choose a disk image as the backup
destination.
An archived backup stores ﬁles inside an archive. You can choose to compress the archive, thus potentially
saving disk space. Such archives let you use some additional features such as encryption or making
incremental backups.
Disk cloning is a special type of backup. It creates copies of your ﬁles in the original format. The main
purpose of disk cloning is to duplicate your entire volume including the system ﬁles. As a result, you can boot
your computer from the duplicate drive if it was your working drive. Cloning takes much longer than backing
up only the user ﬁles. For this reason, cloning is usually combined with more frequent backups of ﬁles you
modify regularly.
Synchronization is used to ensure that the contents of two folders are identical. Synchronization can also be
used to create copies of your ﬁles in a second location and keep them up-to-date. As synchronization
updates only ﬁles that have been changed, it is faster than copying all ﬁles every time.
There is a signiﬁcant diﬀerence between the two types of backup on the one hand, and synchronization and
disk cloning on the other. The ﬁrst two tools can save versions of your ﬁles. This means that if you have set
up daily backups, today's backup can be stored along with yesterday's and earlier ones. Thus, you can
retrieve not only the most recent but also earlier copies of your document. Cloning and synchronization are
designed to keep only the most recent versions of ﬁles.

6

Updating the Program
To have the most recent version of the program, you just need to install updates as soon as they are
released. Before launching the update installer, make sure that the application and supporting ﬁles are at the
default locations. Usually they are if you have followed the installation procedure and didn't change paths or
transfer ﬁles manually. For default ﬁle locations, see in the Uninstalling section.
You can set up to check for updates automatically in the program Preferences.
To check for the latest update manually, use the Get Backup Pro 3 > Check for Updates command in the
main menu. Also, you can visit the Get Backup Downloads page:
https://www.belightsoft.com/products/getbackup/downloads.php
If you are going to install a major update, for instance, update version 3 to version 4, it is recommended that
you deactivate the schedule agent in the Preferences before updating.
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Uninstalling the Program
Before uninstalling the program, you should deactivate the schedule agent and menu icon in the Preferences
dialog. To do this, launch the Get Backup application. Choose Get Backup Pro 3 > Preferences in the
menu. Deselect the Use schedule agent and Show icon in the menu bar checkboxes, and click OK. Quit
the program.
To uninstall Get Backup downloaded from the developer's site, delete the following ﬁles and folders:
/Applications/Get Backup Pro 3.app
~/Library/Preferences/com.belightsoft.GetBackupPro3.plist
~/Library/Application Support/GBP3Launcher
~/Library/Preferences/com.belightsoft.GBP3Launcher.plist
~/Library/Application Support/Get Backup 3
IMPORTANT:
Folders marked with bold font contain auxiliary ﬁles with project settings and some other details. Do not
delete these folders to be able to use Get Backup for restoring. Without having the project settings, it is still
possible extract ﬁles from your backups manually.
“~” means user’s Home folder.
To access any path listed above, copy it. In Finder, choose Go > Go to Folder (Cmd-Shift-G). Then paste
the path into the edit box, and click the Go button.
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Licensing
You can ﬁnd your license code in the purchase conﬁrmation email.
To enter the license code:
1. Open the application.
2. Bring up the License dialog by choosing Get Backup 3 > Pro Registration… in the menu.
3. Enter your name and license code.
It is recommended that you keep the e-mail containing your license code in a safe place in case you re-install
or update the application.
The unlicensed version of Get Backup is fully operational with limited trial period.
To get a license code, you need to purchase and enter the license code. See details on BeLight’s web site:
https://www.belightsoft.com/store/
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Technical Support
The developer of Get Backup oﬀers free technical support.
By E-mail:
support@belightsoft.com
Technical support form on BeLight’s website:
https://www.belightsoft.com/support/
When reporting a problem, please make sure to specify:
The version of Get Backup you are using.
The version of macOS installed on your computer.
Your previous actions that could have lead to the problem.
If the problem persists, describe how to reproduce it.
When necessary, illustrate your report with screenshots (press Cmd-Shift-3 to save a screenshot on
your Desktop).
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Useful Web Resources
BeLight Software home page:
https://www.belightsoft.com/
Get Backup home page:
https://www.belightsoft.com/products/getbackup/
BeLight Software buy page:
https://www.belightsoft.com/store/
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Get Backup End User License Agreement
THIS LICENSING AGREEMENT ("AGREEMENT") IS A LEGAL AGREEMENT BETWEEN YOU, EITHER AN
INDIVIDUAL OR A SINGLE ENTITY, AND BELIGHT SOFTWARE ("LICENSOR"). IF YOU DO NOT AGREE TO
EACH AND EVERY TERM, YOU ARE NOT TO OPEN, USE OR INSTALL THE SOFTWARE. YOU MUST
EITHER RETURN THE SOFTWARE, DOCUMENTATION AND PACKAGING TO THE PLACE OF PURCHASE
OR, IN THE CASE OF DOWNLOADED SOFTWARE, DELETE THE SOFTWARE FROM YOUR COMPUTER
AND/OR ANY OTHER DATA STORAGE DEVICES.
1. GENERAL
The software and documentation accompanying this License whether on disk, on any other media
(collectively the "Software") are licensed to you by BeLight Software ("Licensor") for use only under the terms
of this License, and Licensor reserves all rights not expressly granted to you. The rights granted herein do not
include any other patents or intellectual property rights.
Title and intellectual property rights in and to any content displayed by or accessed through the Software
belong to the respective content owner. This License does not grant you any rights to use such content.
2. LICENSE
Licensor hereby grants to You, and You accept, a non-exclusive license to install and use Software and
Documentation, only as authorized in this license. You agree that You will not assign, sub license, transfer,
pledge, lease, rent, or share Your rights under this license. You may not reverse engineer, decompile or
disassemble the Licensed Software for any purpose whatsoever. The license permits either multiple users to
install and use the software on a single computer, or a single user to install and use the software on multiple
computers. The license doesn't allow multiple users to use the Software on multiple computers.
3. TRANSFER
You may not distribute copies of the Software, in whole or in part, to any third party, nor may you use, rent,
loan, sublicense, or lease the Software to third parties. You may, however, transfer all your rights to use the
Software to another person or legal entity provided that: (a) You also transfer this Agreement, the Software
and all other software bundled or pre-installed with the Software, including all copies, Updates and prior
versions, to such person or entity; (b) You retain no copies, including backups and copies stored on a
computer; and (c) the receiving party accepts the terms and conditions of this Agreement and any other
terms and conditions upon which You legally purchased a license to the Software. Notwithstanding the
foregoing, You may not transfer pre-release or not for resale copies of the Software.
4. ILLEGAL USE
You are not to use the Software, whether directly or indirectly, for any illegal purpose under the laws or
ordinances of Federal, State, or local governments. It is Your sole responsibility to know and understand the
laws and/or ordinances that govern the use of the Software. In the event that You violate any Federal, State
or local law or ordinance by direct or indirect use of the Software, You shall take full legal responsibility for
such illegal use. You shall hold Licensor harmless and without fault and otherwise indemnify Licensor for any
damage, cost or liability incurred by Licensor as a result of any use, whether or not such use is within the
scope of the license set forth herein.
5. UPDATES
If the Software is an Update from an earlier release, you now may use that updated product only in
accordance with this Agreement.
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If the Software is an Upgrade from a previously released version, you must possess a valid license code for
the new version in accordance to the Upgrade policy for that particular Upgrade. You may continue to use
the previous version of the Software on your computer after You receive the Upgrade to assist You in the
transition to the new version, provided that: new and the previous versions are installed on the same
computer; the previous version or copies thereof are not transferred to another party or computer unless all
copies of the Upgrade are also transferred to such party or computer; and You acknowledge that any
obligation BeLight Software may have to support the previous version of the Software may be ended upon
availability of the Update.
6. LICENSOR'S RIGHTS
You acknowledge and agree that the Software and Documentation consists of proprietary, published and
unpublished property of Licensor. You further acknowledge and agree that all right, title, and interest in and to
the Software and Documentation are and shall remain with Licensor. This license conveys to You the right to
install and use the Software and Documentation in accordance with the terms of this license. All rights not
expressly granted here are reserved by BeLight Software. The Licensor will not transmit your personal
information to any third party without your express consent.
7. TERMINATION
This license is eﬀective upon installing the software on any machine, and shall continue until terminated. You
may terminate this Agreement at any time. The Licensor may immediately terminate this License Agreement if
you breach any representation, warranty, agreement or obligation contained or referred to in this License
Agreement. Upon termination, you must dispose of the Software and all copies or versions of the Software
by destroying the Software.
8. LIMITED WARRANTY
BeLight Software provides a thirty (30) day money-back guarantee on the Software. If, during this period, you
are dissatisﬁed with the Software for any reason, BeLight Software will refund your money if you return the
Software and all copies to the place of purchase within thirty (30) days of the date of the original purchase.
THE FOREGOING IS THE SOLE AND EXCLUSIVE WARRANTY OFFERED BY BELIGHT SOFTWARE.
BELIGHT SOFTWARE DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT
NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, WITH REGARD TO THE LICENSED SOFTWARE AND ALL ACCOMPANYING MATERIALS.
BELIGHT SOFTWARE AND ITS AGENTS DO NOT AND CANNOT WARRANT THE PERFORMANCE OR
RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE.
9. LIMITATION OF LIABILITY
IN NO EVENT WILL BELIGHT SOFTWARE OR ITS AGENTS BE LIABLE TO YOU FOR ANY DAMAGES,
CLAIMS OR COSTS WHATSOEVER OR ANY CONSEQUENTIAL, INDIRECT, INCIDENTAL DAMAGES, OR
ANY LOST PROFITS OR LOST SAVINGS. BELIGHT SOFTWARE AGGREGATE LIABILITY AND THAT OF ITS
AGENTS UNDER OR IN CONNECTION WITH THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT
PAID FOR THE SOFTWARE, IF ANY.
10. FEES
You may register your copy of the Software by purchasing a License Code at:
https://www.belightsoft.com/store/. Registering Get Backup with a license code will let you use the program
beyond trial period. You may not distribute the License Code.
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11. SEVERABILITY
Should any term of this license be declared void or unenforceable by any court of competent jurisdiction,
such declaration shall have no eﬀect on the remaining terms hereof.
12. GENERAL PROVISIONS
This License Agreement is personal between You and BeLight Software. It is not transferable and any
attempt by You to rent, lease, sublicense, assign or transfer any of the rights, duties or obligations hereunder.
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND AGREE TO BE
BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT IT IS THE COMPLETE AND
EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN YOU AND BELIGHT SOFTWARE WHICH
SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER
COMMUNICATIONS BETWEEN YOU AND BELIGHT SOFTWARE OR BELIGHT SOFTWARE AGENT(S)
RELATING TO THE LICENSED SOFTWARE.
If you have any questions regarding this Agreement or if you wish to request any information from BeLight
Software please use the address and contact information included with this product to contact BeLight
Software.
© 2022 BeLight Software. All Rights Reserved. BeLight Software and Get Backup are trademarks of BeLight
Software. Mac, the Mac logo, macOS, and Macintosh are trademarks of Apple Computer, Inc. All other
trademarks, registered trademarks, product and/or brand names are the sole property of their respective
owners.
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BeLight Software Privacy Statement
Your privacy is important to us. This Privacy Statement covers how we collect, use, disclose, transfer and
store your information.

Collection and Use of Personal Information
Personal information is data that can be used to identify or contact a single person.
You may be asked to provide your personal information any time you are in contact with BeLight Software.
We may share and use this information consistent with this Privacy Statement. We may also combine it with
other information to provide and improve our products, services, content and advertising. You are not
required to provide the personal information that we have requested, but, if you choose not to do so, in many
cases, we will not be able to provide you with our products or services or respond to any queries you may
have.
What personal information we collect:
When you purchase a product, download software or an update, register for company or product
newsletters, contact us or participate in an online survey, we may collect a variety of information, including
your name, mailing address, phone number and email address.
How we use your personal information:
The personal information we collect allows us to keep you posted on BeLight Software's latest product
announcements, software updates and upcoming events. If you don't want to be on our mailing list,
you can opt out any time by emailing us at: news@belightsoft.com
We also use personal information to help us create, develop, operate, deliver and improve upon our
products, services, content and advertising, as well as for loss prevention purposes.
We may use your personal information to verify identity, assist with identiﬁcation of users and
determine appropriate services.
From time to time, we may use your personal information to send important notices, such as
communications about purchases and changes to our terms, conditions and policies. Because this
information is important to your interaction with BeLight Software, you may not opt out of receiving
these communications.
We may also use personal information for internal purposes, such as auditing, data analysis and
research to improve BeLight Software products, services and customer communications.
If you enter into a sweepstakes, contest or similar promotion, we may use the information you provide
to administer those programs.

Collection and Use of Non-personal Information
We also collect data in a form that does not, on its own, permit direct association with any speciﬁc individual.
We may collect, use, transfer and disclose non-personal information for any purpose. The following are some
examples of non-personal information that we collect and how we may use it:
We may collect information such as occupation, language, zip code, area code, unique device
identiﬁer, referrer URL, location and the time zone where a BeLight Software product is used so that
we can better understand customer behavior and improve our products, services and advertising.
We may collect information regarding customer activities on our websites and from our other products
and services. This information is aggregated and used to help us provide more useful information to
our customers and to understand which parts of our website, products and services are of most
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interest. Aggregated data is considered non-personal information for the purposes of this Privacy
Statement.
If we do combine non-personal information with personal information, the combined information will be
treated as personal information for as long as it remains combined.

Cookies and Other Technologies
BeLight Software websites, online services, interactive applications, email messages and advertisements
may use "cookies" and other technologies, such as pixel tags and web beacons. These technologies help us
better understand user behavior, tell us which parts of our websites people have visited and facilitate and
measure the eﬀectiveness of advertisements and web searches. We treat information collected by cookies
and other technologies as non-personal information. However, to the extent that Internet Protocol (IP)
addresses or similar identiﬁers are considered personal information by local law, we also treat these
identiﬁers as personal information. Similarly, to the extent that non-personal information is combined with
personal information, we treat the combined information as personal information for the purposes of this
Privacy Statement.
If you want to disable cookies, and you're using the Safari web browser, go to Safari Preferences and then to
the Privacy pane to manage your preferences. For other browsers, check with your provider to ﬁnd out how
to disable cookies. Please note that certain features of the BeLight Software website will not be available
once cookies are disabled.
We use this information to understand and analyze trends, to administer the site, to learn about user behavior
on the site, to improve our product and services and to gather demographic information about our user base
as a whole. BeLight Software may use this information in our marketing and advertising services.
In some of our email messages, we use a "click-through URL" linked to content on the BeLight Software
website. When customers click one of these URLs, they pass through a separate web server before arriving
at the destination page on our website. We track this click-through data to help us determine interest in
particular topics and measure the eﬀectiveness of our customer communications. If you prefer not to be
tracked in this way, you should not click text or graphic links in the email messages. Pixel tags enable us to
send email messages in a format customers can read, and they tell us whether mail has been opened. We
may use this information to reduce or eliminate messages sent to customers.

Disclosure to Third Parties
At times, BeLight Software may make certain personal information available to strategic partners that work
with BeLight Software to provide products and services or that help BeLight Software market to customers.
Personal information will only be shared by BeLight Software to provide or improve our products, services
and advertising; it will not be shared with third parties for their marketing purposes.
Service Providers
BeLight Software shares personal information with companies that provide services such as information
processing, fulﬁlling customer orders, delivering products to you, managing and enhancing customer data,
providing customer service, assessing your interest in our products and services and conducting customer
research or satisfaction surveys. These companies are obligated to protect your information.
Services we use and their respective privacy policies:
Google Analytics is used to analyze website visitors' behavior and activity:
https://policies.google.com/privacy
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Vimeo is used for video content playback:
https://vimeo.com/privacy
FastSpring is used for online order processing:
https://fastspring.com/privacy/
Others
It may be necessary - by law, legal process, litigation and/or requests from public and governmental
authorities within or outside your country of residence - for BeLight Software to disclose your personal
information. We may also disclose information about you if we determine that disclosure is reasonably
necessary to enforce our terms and conditions or protect our operations or users. Additionally, in the event of
a reorganization, merger or sale, we may transfer any and all personal information we collect to the relevant
third party.

Protection of Personal Information
BeLight Software takes the security of your personal information very seriously. BeLight Software online
services, such as the BeLight Software website store and embedded into software store, protect your
personal information during transit using encryption such as Transport Layer Security (TLS). When your
personal data is stored by BeLight Software, we use computer systems with limited access and encrypted
storage.
When you use some BeLight Software products, services or applications, or post on a BeLight Software
forum, chat room or social networking service, the personal information and content you share is visible to
other users and can be read, collected or used by them. In these instances, you are responsible for the
personal information you choose to share or submit.

Integrity and Retention of Personal Information
BeLight Software will retain your personal information for the period necessary to fulﬁll the purposes outlined
in this Privacy Statement unless a longer retention period is required or permitted by law.

Access to Personal Information
Access, correction or deletion requests can be made via email at:
sales@belightsoft.com

Children
If we learn that we have collected the personal information of a child under 13, or equivalent minimum age
depending on jurisdiction, we will take steps to delete the information as soon as possible.
Parents can contact us via email at:
sales@belightsoft.com

Third-party Sites and Services
BeLight Software websites, products, applications and services may contain links to third-party websites,
products and services. Our products and services may also use or oﬀer products or services from third
parties. Information collected by third parties, which may include such things as location data or contact
details, is governed by their privacy practices. We encourage you to learn about the privacy practices of
those third parties.
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Commitment to Your Privacy
To ensure that your personal information is secure, we communicate our privacy and security guidelines to
BeLight Software employees and strictly enforce privacy safeguards within the company.

Questions
If you have any questions or concerns about the BeLight Software Privacy Statement or data processing, or
if you would like to make a complaint about a possible breach of local privacy laws, please contact us at:
sales@belightsoft.com
BeLight Software may update its Privacy Statement from time to time. When we change the policy in a
material way, a notice will be posted on our website along with the updated Privacy Statement.
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The Main Window
The main window provides tools for:
Creation of backups
Creation of archived backups
Cloning disks
Synchronization
We use the term "project" to call tasks that can be set up and performed individually as backing up some
ﬁles or cloning a drive.

1 – Choose here the project type: backup, archived backup, disk clone or synchronization.
2 – A list of projects.
3 – Buttons to add or delete projects.
4 – Settings of the current project. The current project is highlighted in the list, and its content is displayed in
the main part of the window.
5 – An option to restore ﬁles from the selected backup. Only backup and archived backup projects have this
button.
6 – The status line. It the program state or details about the currently running task.
7 – The Run button. It starts the task related to the selected project (e.g. starts backing up ﬁles).
8 – The progress bar.
9 – The middle of the main window displays ﬁles and folders of the current project.
10 – This button opens the Log Window.
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11 – The Suspend Scheduler button lets you turn oﬀ the scheduler for some time.
If the program was started automatically by a schedule, the main window will be minimized. After completing
the scheduled tasks, the program will quit.
All types of projects support duplication. You can choose this option from the context menu by right-clicking
on a project, or by selecting Process > Duplicate. This might be useful if you need to backup or sync the
same set of ﬁles to diﬀerent destinations (e.g. alternate backup disks on even and odd weekdays). Notice
that the schedule of the duplicate will be set to the same time but not activated by default.
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The Preferences Dialog

1 - Automatically check for updates lets you specify how frequently the program checks for updates.
2 - The option to store the administrator's password in the Keychain. Once you activate this option, be ready
to input the user name and password. To remove the password from the Keychain, deactivate this option.
3 - Automatically start up Get Backup to perform scheduled tasks.
4 - Show the program icon in the menu bar.

The icon indicates whether the scheduler is in the regular mode or suspended. It also gives you options to
suspend or resume the scheduler, and to bring up the main window of the program or its Preferences.
5 - Send only error messages to the system Notiﬁcations. This option doesn't aﬀect the log which always
receives all messages.
6 - Limit the number of the most recent log ﬁles stored on your computer.
7 - Determine where log ﬁles should be saved. You can specify a new location for log ﬁles or open their
location in Finder.
8 - Choose a folder for temporary ﬁles. Normally, the system folder is used. Using a custom folder may be
helpful when:
There is not enough space on the system volume.
While creating a multi-volume archive (with archive size limit option), the whole path to a temporary ﬁle
is limited by 80 characters. If the program runs out of characters, you can change the location of
temporary ﬁles. Choose a temporary folder that is as close to the root point of the ﬁle system as
possible. So, a short path like "/Volume2/" is better than a long one
"/Volume2/Users/Bobby/Documents/Backups/Temporary/".
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Get Backup Menus
Get Backup
Edit
Process (Backup)
Process (Archive)
Process (Clone)
Process (Synchronize)
Window
Help
The "Get Backup" Menu
About Get Backup

Display information about the program.

Pro Registration…

Open the registration dialog box.

Check for Updates

Check for the latest update on the Internet.

Preferences (Cmd-",")

Bring up the program preferences dialog.

Quit Get Backup (CmdQ)

Quit the application.

The "Edit" Menu
Cut (Cmd-X)

Cut selected text.

Copy (Cmd-C)

Copy selected text into the Clipboard.

Paste (Cmd-V)

Paste text from the Clipboard.

Select All (Cmd-A)

Select all text or select all the items in the ﬁle list.

The "Process" Menu: Backup project
Start Backup

Run the current backup project.

New

Create a new backup project.

Duplicate

Duplicate the current project.

Remove Project…

Remove the current backup project.

Restore…

Restore ﬁles and folders from the current backup.

Restore from…

Restore ﬁles and folders from a backup which is not listed in the program. You
should specify the location of this backup.

Project Properties…

Open the properties of the current backup project.

Add File…

Add a ﬁle or folder to the current backup project.

Remove File

Remove a selected ﬁle or folder from the current backup project.

Show in Finder

Open a folder containing a selected ﬁle or folder in Finder.

Suspend Scheduler…

Stop the scheduler for a speciﬁed period of time.

Create Disk Image…

Open the dialog where you can create a disk image.
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The "Process" Menu: Archive project
Start Backup

Run the current backup project.

New

Create a new backup project.

Open…

Open a backup project saved in the past.

Duplicate

Duplicate the current project.

Save Project…

Save the current backup project.

Remove Project…

Remove the current backup project.

Restore…

Restore ﬁles and folders from the current backup.

Project Properties…

Open the properties of the current backup project.

Add File…

Add a ﬁle or folder to the current backup project.

Remove File

Remove a selected ﬁle or folder from the current backup project.

Show in Finder

Open a folder containing a selected ﬁle or folder in Finder.

Review Content…

Open a detailed list of the ﬁles and folders in the backup project.

Suspend Scheduler…

Stop the scheduler for a speciﬁed period of time.

Create Disk Image…

Open the dialog where you can create a disk image.

The "Process" Menu: Clone project
Start Cloning

Start cloning the selected disk volume.

Start Clean Cloning

Start the replication of the disk volume group with help of the Apple Software
Restore utility.

New

Create a new disk cloning project.

Duplicate

Duplicate the current project.

Remove Project…

Remove the current project.

Project Properties…

Open the properties of the current backup project.

Suspend Scheduler…

Stop the scheduler for a speciﬁed period of time.

Create Disk Image…

Open the dialog where you can create a disk image.
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The "Synchronize" Menu
Start Synchronization

Synchronize the two selected folders.

New

Create a new synchronization project.

Duplicate

Duplicate the current project.

Remove Project…

Remove the current project.

Analyze

Compare the two selected folders.

Project Properties…

Open the properties of the current backup project.

Choose Left Target…

Choose a folder to synchronize its content with another folder.

Choose Right Target…

Choose a folder to synchronize its content with another folder.

Suspend Scheduler…

Stop the scheduler for a speciﬁed period of time.

Create Disk Image…

Open the dialog where you can create a disk image.

The "Window" Menu
Zoom

Fit the program window to the screen size.

Minimize (Cmd-M)

Minimize the currently active window.

Close (Cmd-W)

Close the active window.

Enter Full Screen (CmdF)

Fit the program window to the screen size.

Backup View (Cmd-1)

Open the backup tool.

Archive View (Cmd-2)

Open the archived backup tool.

Clone View (Cmd-3)

Open the disk cloning tool.

Synchronize View (Cmd4)

Open the synchronization tool.

Show Log (Cmd-L)

Open or close the log window.

Clear Log

Remove records from the log window.

The "Help" Menu
Get Backup Help

Open Get Backup documentation.

BeLight Software Web
Site…

Open developer's web site.

Send Feedback…

Send feedback to the developers by e-mail.

Online Registration…

Open the on-line registration form.
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The Log
Get Backup displays information about its progress in the Log Window. Unlike the status line, which
indicates only the current state, the Log Window lists a history of records related to the current and previous
sessions. In case of an error, you can scroll back to see what has been done and which operation has failed.
If the program is set up to run your tasks automatically, the Log Window gives you a convenient way to ﬁnd
out if the recent tasks were completed successfully.
To open the Log Window, click on the Show Log Window in the main window, or select Window > Show
Log in the main menu.
The program also saves logs on your local drive. Log ﬁles are even more detailed than logs in the Log
Window. Every time you open the program, it creates a new log ﬁle. The latter contains progress and
diagnostic messages.
To access log ﬁles, click the Log History button in the Log Window.
In the The Preferences Dialog, you can choose a new folder to save logs, and limit the number of old logs to
be stored.
The program stores logs in the ZIP format. If you wish to read a log, double-click on the ﬁle to extract a text
ﬁle from it.
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The Backup Workspace
To open the backup tools, click the ﬁrst button in the main window or press Cmd-1.

1 – List of backup projects. Along with the project name, there is the date and time of the most recent
backup.
2 – List of ﬁles and folders included to the current project.
3 – Add or delete projects.
4 – Project properties.
5 – Open the Restore dialog to restore ﬁles from the backup.
6 – An option to exclude items from new backups without deleting them from the backup project. If you
exclude a folder, all its content will be excluded too.
7 – Add a ﬁle or folder to the project.
8 – Add ﬁles to the project from a predesigned list. Each item in the list corresponds to user data such as
contacts or a photo library.
9 – Remove a ﬁle or folder from the project. This button will actually delete top level items from the list, but it
will exclude a subfolder or ﬁle inside a folder.
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Creating Backups
To work with backups, make sure that the backup tool is activated. Choose Window > Backup View or
press Cmd-1.
The APFS and Mac OS Extended ﬁle systems on the local destination drive lets you use its space more
eﬃciently by creating incremental backups. If the local destination disk has a diﬀerent ﬁle system, or if you
want to save backups on a remote disk, you should choose the Disk Image option. It will be discussed in
Step 2.
If your project includes ﬁles that are protected by the operating system (you may be unaware about that), you
will need to activate the Use administrator privileges check box in the project settings, and approve this
with admin's password in order to let the program access those ﬁle.
Step 1: Create a new backup project
Click the Plus button at the bottom of the project list. Then type in the project name.
Step 2: Set up the backup
As soon as you add a new project, the program will open the project settings. You can set up the project right
away, or do this later. Note that you must select the backup destination drive and folder before running the
project.
Along with the destination, you should choose whether you want your data to be stored as original ﬁles and
folders, or inside a disk image. In the ﬁrst case, select Folder near the destination disk name. This is the
default option. The two other options are Disk Image and Disk Image (Encrypted). To ﬁnd out why you might
want to use a disk image, read the Using Disk Images section.
Step 3: Add ﬁles and folders to the project
To add a ﬁle or folder to the project, use any of these ways:
Drag and drop a ﬁle or folder to the list on the main window.
Click the File+ button and select a ﬁle or folder. You can select multiple items at the same time.
Choose Process > Add File… in the main menu and select a ﬁle or folder. You can select multiple
items at the same time.
By clicking the Apps Data+, you can choose a preset. Each of them adds user's data related to one of listed
apps.
To delete an item from the list, select it and click the File- button below the list.
Step 4: Create a backup
To create a backup, click the Start button.
If you have activated scheduled creation of backups, the process will start automatically at the stated time.
If the When source and destination are mounted option is activated in the Properties dialog, the program
can also start the process automatically when you connect a USB disk to the computer.
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The Backup Properties
To open the Properties dialog, click the gear icon below the project list or choose Process >
Properties/Schedule… menu item.

1 - The color of the tag in the project list. This can help you highlight projects by importance, frequency of
creation or by other principle.
2 - The project name. It is displayed in the main window. Note that projects with identical names are not
allowed.
3 - The backup destination drive. Here you can choose a volume, removable drive, network drive or another
storage available on your computer. If you select a network drive, the program will display two more controls.
The Network automount check box allows the program to mount the selected disk automatically before
writing ﬁles to it. The Mount button lets you mount the selected disk manually. (*)
4 - A way to store backed up ﬁles. The default Folder option lets you store ﬁles in the destination folder
directly. If the Disk Image option is selected, a disk image will be created in the destination folder. This disk
image will contain your ﬁles. You can also choose an encrypted disk image. (*)
5 - Select a folder on the destination drive. (*)
6 - Information about the possibility to create a backup with selected destination drive and folder.
7 - If the destination folder or original ﬁles are located on a network drive, you can choose to mount it
automatically.
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8 - Disk image maximum size. This option is available when a disk image is selected as a container for the
backup. Disk images can increase their capacity when you add more ﬁles. You can specify the maximum
space the disk image can take. By default, the maximum is set to all available space on the destination disk.
You have an option to input an arbitrary maximum size, but be aware of the physical capacity of the
destination volume.
9 - Run the program with the administrator privileges. To activate this option, you will have to input the
administrator's password.
10 - The Exclude section allows you to create a set of rules for automatic exclusion of ﬁles from the archive.
By selecting the By pattern check box, you can create your own rule. This is described in the Exclude Files
by the Pattern section.
11 - The option to sync or ignore the extended attributes. Files on your Mac may have extended attributes
that are not supported by the destination ﬁle system. In this case, you can tell the program to ignore them to
avoid error messages in the log.
12 - Activate or deactivate removing old versions of the backup automatically.
13 - Activate the automatic backup creation when the source and destination volumes are mounted.
14 - Activate the automatic backup creation by schedule.
Note that changing the options marked with the asterisk (*) make the program to create a new destination
folder or disk image. Consequently, backups will be distributed between several folders, disk images or both.
This can also aﬀect the possibility to restore from some of backups because the Restore dialog restores only
from the currently selected destination.

Exclude Files by Pattern
A folder added to your project may contain some ﬁles wich you don't want to back up. The Exclude tool can
help you automatically exclude such ﬁles.
You can choose a predeﬁned ﬁle type or create your own pattern. To do this, activate the By pattern option
and select a ﬁle you want to exclude. For example, if you select a report.txt ﬁle and choose the "the same
extension" option, all .txt ﬁles will be excluded.
A pattern can contain a ﬁle name or extension, or both. Several patterns can be combined to create a
complex rule.
To add a pattern:
1. Click the Select button.
2. Select one of radio buttons:
• the same extension to exclude all ﬁles of the same type as the sample ﬁle has (the part of the full ﬁle
name after the most right period.
• the same name to exclude all ﬁles with the same name as the sample ﬁle has (the part of the full ﬁle
name before the most right period).
• the same name and extension to exclude all ﬁles with the same name and extension as the sample
ﬁle.
3. Choose a sample ﬁle to use its name or extension as a pattern.
4. To join the current pattern with the existing one, select the Combine with previous pattern check
box. This way you can exclude several ﬁle types from the archive. If you deselect the check box, a new
pattern will replace the existing one.
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5. Click Capture.
You can create a pattern manually by typing it into the edit box. You should follow these rules:
All patterns consist of three elements: ﬁle name, period (.), and extension.
Use the asterisk symbol (*) instead of the ﬁle name or extension to indicate a ﬁle with any name or any
extension. Example: *.jpeg means "any ﬁle in the JPEG format".
Don't add any extra symbols (quotation marks, spaces, commas, etc.) unless they are a part of the ﬁle
name or extension.
Use the | symbol (so called pipe) to separate several patterns.

Removing Old Backups
The more times you run the same backup project, the more versions of this backup can be stored on your
drive taking more and more space. The program can delete old versions of the backup (let's call them old
backups) in order to free disk space for new ones. Old backups to be removed are removed instantly.
The program removes old backups when you close it.
An old backup will be removed only if a new version of the backup is created successfully.
There are two ways to deﬁne which of the backups should be deleted. The ﬁrst method lets you deﬁne for
how long to store backups by selecting the After option. If you set "After 2 Months", the program will keep
backups created within the two recent months. Backups created earlier will be deleted.
The second method allows you to set up the maximum number of versions stored at the same time using the
Exceeding option. If you select "Exceeding 3 versions", the program will keep the three most recent backups.
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Backup Storage
In the backup destination folder, the program creates a folder dedicated to a particular backup project. The
name of this folder is the project name plus an underscore symbol plus an alphanumeric preﬁx. For example,
if your project is called "Documents", the folder name can look as Documents_4FFA23B7-207C-42BF-A9DBA500023DD276. The preﬁx is generated automatically and ensures that projects with the same name will not
mix up their backup folders.
Inside the backup folder, there are:
gb3info.plist - an auxiliary ﬁle needed to store some information related to the backup.
b3_2021-02-03_17-54-28 - a folder to store a version of backed up data. There can be one or many of
such folders with diﬀerent date and time in their names. Every time you run a backup project, the
program creates one more folder, and copies the current version of your ﬁles into it.
If we look at the list of items included to the project, there are ﬁles and folders that are not inside of any other
folder. Let's talk about them as top level items. So, the program places each top level item into a folder with
the same name and a unique preﬁxes such as ".wrp1", ".wrp2" and so on. If you go deeper in subfolders, the
ﬁle structure will be exactly the same as in the original folders.
So in the whole, the backup storage content may look this way:
Documents_4FFA23B7-207C-42BF-A9DB-A500023DD276
gb3info.plist
b3_2021-02-03_17-54-28
Document_1.txt.wrp1
Document_1.txt
Document_2.txt.wrp2
Document_2.txt
b3_2021-03-03_17-54-28
Document_1.txt.wrp1
Document_1.txt
Document_2.txt.wrp2
Document_2.txt
Folder_1.wrp3
Folder_1
Folder_2.wrp3
Folder_2
Document_3.txt
Document_4.txt
Bold font marks the backed up ﬁles and folders. The rest were used to organize the backup storage. To
restore manually, you should copy the items in bold to the proper locations.
At the beginning of the backup process, a folder to store a new backup is named
"GB3ProcessTemporaryFolder". When all ﬁles are successfully copied in this folder, the program gives it a
proper name as explained earlier. If the process wasn't ﬁnished, the temporary folder remains until the next
backup session. If ﬁles in the temporary folder are up-to-date, the program will not copy them again in the
new session. This helps to ﬁnish the process faster.
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Quasi-Incremental Backup Type
If the local destination drive has the APFS or Mac OS Extended ﬁle system, the program will create
incremental backups. This means that ﬁles, which have not been changed since the previous backup, will not
be copied to the backup storage again. Due to this, the program can save space on your destination drive,
and may ﬁnish each backup session faster.
Instead of copying an unchanged ﬁle to a new backup, the program creates a hard link (feature of the ﬁle
system) to a copy of this ﬁle already present in one of previous backups. So, there is no need to add another
copy of the ﬁle and as a consequence take more disk space for it. To the user, the hard link behaves as it was
the ﬁle itself. So, all backups appear to be full backups.
With a ﬁle system on the destination drive other than APFS or Mac OS Extended, hard links are not
supported. In such case, the program will create full backups. Each of them will contain copies of all ﬁles
included to the project.
Incremental backups cannot be created on network disks because hard links cannot be used.
To create an incremental backup on a disk that doesn't support hard links, you can choose to create a disk
image on the selected storage when you set up a new backup project. The disk image will have a proper ﬁle
system.
Using Disk Images
A disk image is a ﬁle (actually a bundle) that can be mounted as a volume in Finder. A disk image can have a
ﬁle system that is diﬀerent from one the physical storage has. Get Backup can use a disk image with the
proper ﬁle system as a container to store your ﬁles.
The program mounts and unmounts disk images automatically when it backs up or restores ﬁles. Since disk
images are fully supported by macOS, you can mount them manually in Finder and access your ﬁles without
Get Backup.
Files and folders inside the disk image have the same structure as described at the beginning of this page.
In order to create a disk image to store your backup, you should select the Disk Image or Disk Image
(Encrypted) option in the Properties dialog.
An encrypted disk image can be mounted only if the correct password is provided. If you want to backup
your data automatically, you should allow the program to save the password to the Keychain.
An important property of disk images is the maximum size. When you create a new backup project, you
should set an adequate maximum disk image size. For example, if your data takes 200 MB of disk space and
you want to keep the last 5 full backups, the disk image size should be at least 1 GB that is 5 * 200 MB. You
should add extra 10-20% to this estimate to be sure that your ﬁles will ﬁt.
The initial size of a new disk image is about 5% of the maximum or less. When ﬁles are added to the disk
image, it becomes larger to accomodate new ﬁles. The disk image will grow up until it reaches the maximum
size. When it is not enough space to complete the task, the program will oﬀer you to increase the maximum
size of the existing disk image, or create a bigger one.
If you delete some ﬁles from a disk image, it will not shrink itself. The program cannot free unused disk
space. You can only do this using the following Terminal command:
hdiutil compact
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To run this command, open Applications/Utilities/Terminal.app. Copy and paste the command above. Then
drag the disk image from Finder and drop it onto the Terminal window. Then hit the Return key. Note that
there must be a space symbol between "compact" and the path to the disk image. If the disk image is
encrypted, you will be asked to input the password. If you unsure how to use Terminal, don't use it. Most of
actions that can be performed in Terminal have no UNDO function.
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Backup Auxiliary Files
The program stores settings and other information related to backup projects in Projects.plist and
gb3info.plist ﬁles. Without these ﬁles, the program cannot back up and restore your data.
It is recommended that you save a copy of Projects.plist in the same folder where your backup is located.
The Projects.plist ﬁle is one for all of your projects. It is located in the Backups folder. To ﬁnd this folder, use
the path speciﬁed on the Uninstalling the Program page.
gb3info.plist ﬁles are located inside the destination folder of each backup project. Every project has its own
gb3info.plist.
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The Archived Backup Workspace
To open the archived backup tools, click the second button in the main window or press Cmd-2.

1 – List of backup projects. Along with the project name, there is the date and time of the most recent
backup.
2 – List of ﬁles and folders included to the current project.
3 – Add or delete projects.
4 – Project properties.
5 – Open the Restore dialog to restore ﬁles from the backup.
6 – An option to exclude items from new backups without deleting them from the backup project. If you
exclude a folder, all its content will be excluded too. To access ﬁles inside folders, click the View Content
button.
7 – Add a ﬁle or folder to the project.
8 – Add ﬁles to the project from a predesigned list. Each item in the list corresponds to user data such as
contacts or a photo library.
9 – Remove a ﬁle or folder from the project.
10 – Open the full list of ﬁles included to the project.
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Backup Archive Types
Get Backup can handle two types of backup archives. Your choice should depend on the physical amount of
memory available on the backup storage, on how frequently you create backup archives, on the reliability you
expect from your archives, etc. One type may be optimal for some speciﬁc case but not the best for others.
To set up a type for the current backup archive, choose Backup > Properties/Schedule menu item and
select a type in the Backup Method section.
You can see the diﬀerence between the discussed backup types if:
1. Your backup project includes several ﬁles.
2. You create a sequence of backup archives.
3. One or several (but not all) ﬁles have been changed since the last archive creation.

Full Backup
A full backup contains copies of all ﬁles and folders listed in the backup project. The size of a full backup
archive can be estimated as the total size of the original ﬁles. If you enable the compression feature, the
archive can be smaller.
You can deﬁne whether to store previous versions of the backup, or to keep only the most recent one. To do
this, use the Keep previous backups option in the project properties.
To restore ﬁles, you should have only the last version of the archive.

Incremental
An incremental archive contains only ﬁles that were changed after the previous backup archive (full or
incremental) had been created. The archive size depends on the total size of modiﬁed ﬁles and can be much
smaller than the full archive.
New incremental archives have unique names. The program places new archives into the folder where the
previous archives are located.
To restore ﬁles, you should have all the previous incremental archives including the full archive.
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Creating Archived Backups
To work with archived backups, make sure that the archived backup tool is activated. Choose Window >
Archive View or press Cmd-2.
If your project includes ﬁles that are protected by the operating system (you may be unaware about that), you
will need to activate the Use administrator privileges check box in the project settings, and approve this
with admin's password in order to let the program access those ﬁle.
Step 1: Create a new backup project
Click the Plus button at the bottom of the project list. Then type in the project name.
Step 2: Set up the backup
As soon as you add a new project, the program will open the project settings. You can set up the project right
away, or do this later. Note that you must select the backup destination drive and folder before running the
project.
Step 3: Add ﬁles and folders to the project
To add a ﬁle or folder to the project, use any of these ways:
Drag and drop a ﬁle or folder to the list on the main window.
Click the File+ button and select a ﬁle or folder. You can select multiple items at the same time.
Choose Process > Add File… in the main menu and select a ﬁle or folder. You can select multiple
items at the same time.
By clicking the Apps Data+, you can choose a preset. Each of them adds user's data related to one of listed
apps.
To delete an item from the list, select it and click the File- button below the list.
Step 4: Create a backup archive
To create a backup archive, click the Start button.
If you have activated scheduled creation of backups, the process will start automatically at the stated time.
If the When source and destination are mounted option is activated in the Properties dialog, the program
can also start the process automatically when you connect a USB disk to the computer.
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The Backup Content List
To preview the detailed list of ﬁles and folders in a project, click the View Content button in the main window.
The main window lists only top level items.
In the list, you can exclude certain items by unchecking them. Excluded items remain listed but they will not
get into the backup. The program also automatically unchecks items according to the Exclude settings.

A column to the right from the ﬁle name indicates the presence of the item in the original location. No icon
means that the original ﬁle cannot be found.
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The Archived Backup Properties
To open the Properties dialog, click the gear icon below the project list or choose Process >
Properties/Schedule… menu item.

1 - The color of the tag in the project list. This can help you highlight projects by importance, frequency of
creation or by other principle.
2 - The project name. It is displayed in the main window. Note that projects with identical names are not
allowed.
3 - The backup destination drive. Here you can choose a volume, removable drive, network drive or
CD/DVD/Blu-ray drive available on your computer.
4 - Select a folder on the destination drive.
5 - The Network automount check box allows the program to mount the selected disk automatically before
writing ﬁles to it. The Mount button lets you mount the selected disk manually. These two controls are
available if you select a network drive as the destination.
6 - Run the program with the administrator privileges. To activate this option, you will have to input the
administrator's password.
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7 - The Exclude section allows you to create a set of rules for automatic exclusion of ﬁles from the archive.
By selecting the By pattern check box, you can create your own rule. This is described in the Exclude Files
by the Pattern section.
8 - An option to keep only the most recent version of the backup or all of them. When the check box is
activated, running the backup project will add new versions of the backup to the destination folder taking
more and more disk space. In this case, you can delete old backups manually. This feature is available only
with the Full backup type.
9 - The type of the backup project. See Backup Archive Types for more detail.
10 - An option to create compressed archives. With compression, archives usually take less disk space.
11 - The archive encryption method. If encryption is activated, you will have to input a password when you
backup your ﬁles, and when you restore them. You can choose to remember the password in the Keychain.
12 - The Split size control allows you to split the archive into pieces (volumes) so that the size of any
individual volume does not exceed the stated size. This is useful when you write backups on CD/DVD discs.
13 - Activate the automatic backup creation when the source and destination volumes are mounted.
14 - Activate the automatic backup creation by schedule.

Exclude Files by Pattern
A folder added to your project may contain some ﬁles which you don't want to back up. The Exclude tool can
help you automatically exclude such ﬁles.
You can choose a predeﬁned ﬁle type or create your own pattern. To do this, activate the By pattern option
and select a ﬁle you want to exclude. For example, if you select a report.txt ﬁle and choose the "the same
extension" option, all .txt ﬁles will be excluded.
A pattern can contain a ﬁle name or extension, or both. Several patterns can be combined to create a
complex rule.
To add a pattern:
1. Click the Select button.
2. Select one of radio buttons:
• the same extension to exclude all ﬁles of the same type as the sample ﬁle has (the part of the full ﬁle
name after the most right period.
• the same name to exclude all ﬁles with the same name as the sample ﬁle has (the part of the full ﬁle
name before the most right period).
• the same name and extension to exclude all ﬁles with the same name and extension as the sample
ﬁle.
3. Choose a sample ﬁle to use its name or extension as a pattern.
4. To join the current pattern with the existing one, select the Combine with previous pattern check
box. This way you can exclude several ﬁle types from the archive. If you deselect the check box, a new
pattern will replace the existing one.
5. Click Capture.
You can create a pattern manually by typing it into the edit box. You should follow these rules:
All patterns consist of three elements: ﬁle name, period (.), and extension.
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Use the asterisk symbol (*) instead of the ﬁle name or extension to indicate a ﬁle with any name or any
extension. Example: *.jpeg means "any ﬁle in the JPEG format".
Don't add any extra symbols (quotation marks, spaces, commas, etc.) unless they are a part of the ﬁle
name or extension.
Use the | symbol (so called pipe) to separate several patterns.
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Burning Backups on CD, DVD or Blu-ray
You can save your backup archives directly to CD, DVD or Blu-ray discs. Get Backup allows you to use the
disc burning capabilities provided by macOS.
To burn a backup archive using Mac OS capabilities:
1. Choose the CD/DVD/Blu-ray drive in the Backup destination drop-down menu in the backup project
properties.
2. Insert a blank, recordable disc into the drive.
3. Click the Start button or choose Backup > Start Backup in the menu.
4. Click the Burn button to start burning.

If you have inserted a rewritable disc, the program can ask you to erase it before burning your backup.
To access more options, click the button in the top right corner.

Here you can select the Leave disc appendable check box to be able to add more ﬁles if there is
enough free space on the disc. Note that only appendable (multisession) discs are supported.
CD, DVD or Blu-ray discs can be used for incremental or full backups.
You should remember that the software requires some extra space on the system hard disk for temporary
ﬁles.
Multi-Volume Archives
If your backup archive requires more space than one disc provides, you can burn it onto several disks. Select
the disc capacity in the Archive size pop-up menu in the project Properties dialog. The program will split the
archive into several parts. Then these parts will be merged when you restore ﬁles.
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Archive File Names
The backup archive name reﬂects the chosen backup method and the creation time. The following format is
used:
method_project_YYYY-MM-DD_hh-mm-ss_lp.ext
Here:
method – backup method: "full" – full, "incr" – incremental;
project – the name of the backup project;
YYYY – the year of the creation (for instance, 2016);
MM – month (for instance, 02);
DD – day (for instance, 11);
hh – hour (for instance, 16);
mm – minutes (for instance, 05);
ss – seconds (for instance, 14);
_lp – present in all ﬁle names;
ext – ﬁle extension (see below).
For example, the archive name "full_Documents_2016-02-11_16-05-14_lp.tgz" tells us that it is a full archive
and it was created on February 11, 2016 at 16:05:14, with compression enabled.
File Name Extensions
The ﬁle name extension indicates whether or not the archive was compressed, encrypted or split onto parts.
If multiple features were activated, multiple extensions will be attached to the ﬁle name one after another.
Extension

Compression Encryption

.tar

–

–

.tgz

+

–

.tar.bfe

–

Blowﬁsh

.tgz.bfe

+

Blowﬁsh

.tar.3des

–

Triple DES

.tgz.3des

+

Triple DES

.tar.aes128

–

AES-128

.tgz.aes128

+

AES-128

.tar.aes256

–

AES-256

.tgz.aes256

+

AES-256

Backup archives may be split into parts (the Archive size limit option in the Backup Properties). The
consecutive parts will have the additional extension added in the end. The extension consists of three letters
that change in the alphabetical order depending on the part number:
.tar.aaa – part 1;
.tar.aab – part 2;
.tar.aac – part 3;
and so on.
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The Archived Backup Project File
When you create a backup archive, along with the archive itself, Get Backup creates a backup project ﬁle
that contains information necessary to restore the archived ﬁles or create new archives. This additional ﬁle
has the "bif" ﬁle name extension. The beginning of this ﬁle's fame coincides with the project's name.
The program saves the backup project ﬁle in user's Library folder. The path to the project ﬁle is speciﬁed on
the Updating and Uninstalling the Program page.
When you choose Backup > Remove from List in the menu, the program deletes the corresponding "bif"
ﬁle. To be able to work with your backup in the future, save the project ﬁle using Process > Save Project…,
and only then remove your project from the list. To open your backup project again, choose Backup >
Open… and select its "bif" ﬁle.
It is recommended that you save the project in the same folder where the corresponding backup archives are
located. When you relocate archives, make copies of them, or burn them to discs, place the project ﬁle
together with the archives.
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Using Get Backup to Restore Files
To restore ﬁles from a backup, you should have the backup itself and all related auxiliary ﬁles (see Backup
Auxiliary Files for regular backups or Backup Project File for archived backups). In the case of a multi-volume
archive, all the parts must be present.
To restore ﬁles:
1. In the main window, select a backup project you want to restore. Then click the Restore button. The
Restore dialog will open.
2. By default, the program selects the most recent backup in the pop-up menu. If you need an earlier
version of some ﬁle, select the corresponding backup from the list using the creation date.
3. Select ﬁles you want to restore. To select multiple ﬁles, use the Cmd or Shift keys. To restore all ﬁles,
you don't have to select them.
4. Choose whether to restore to the original or to a custom folder.
5. Click the Restore All button to restore all ﬁles or click Restore Selected to restore only selected ﬁles.
If the backup was encrypted, be ready to input the password.
Note that when you restore ﬁles to the original location, the program will replace ﬁles on your disk with ﬁles
from the backup. If you want to keep both versions of your ﬁles, restore ﬁles to another folder.
If your backup project is not listed in the program, your actions in order to restore ﬁles from this backup will
diﬀer depending on the backup type. If you have a regular backup, choose the Process > Restore from…
command from the main menu and select the folder containing your backup (the top level folder explained in
the Backup Storage section). The program will open the Restore dialog. You can use this dialog as it was
described earlier on this page.
To restore from an archived backup, you should open it in the program using the Process > Open…
command. The further steps will be the same as described above.
You are limited to restore from the storage that is currently speciﬁed as the backup destination in the project
Properties dialog. If you changed the path to the destination, only the current path will be searched for the
backup. If some versions of the backup were deleted or moved to another location, their content will not be
available in the Restore dialog.
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The Restore Dialog
The Restore dialog contains the restoration options. To open it, click the Restore button in the main window.

1 – The list of already created backups for the current project. You can choose one of them to restore the
included ﬁles. A tick mark near the ﬁle name (archived backups only) indicates that a ﬁle is present in the
selected backup.
2 – The list of ﬁles and folders in the current backup project. You can select one or several ﬁles to restore only
them.
3 – Select where to restore ﬁles. If Restore to custom folder is selected, the program will ask you to choose
a folder.
4 – Select Use selected archive only to restore ﬁles only from an archive selected in the drop-down menu at
the top. This option is available only for incremental backups. It can speed up the restoration process
because the program wouldn't have to process all incremental archives created before the selected one.
Before using this option, make sure that a tick mark is present next to a ﬁle you want to restore. If there is no
tick mark, choose another archive where the ﬁle is ticked, or restore with this option deactivated. This option
is available only for archived backups.
5 – Select Ignore info about ﬁle presence to try to restore ﬁles from a backup selected in the drop-down
menu even if they are marked as absent. This option is eﬀective with backup projects created in older
versions of Get Backup. This option is available only for archived backups.
6 – The Restore Selected button restores only ﬁles selected in the list.
7 – The Restore All button restores all ﬁles.
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Restoring Files Manually
To restore from a non-archived backup, just copy ﬁles and folders from it. This page is aimed to explain how
to restore from archived backups.
Get Backup uses standard ﬁle formats: TAR for creating archives and GZIP for compression. These formats
are natively supported on macOS and other operating systems. This makes it possible to extract ﬁles from
the archive without using the Get Backup application. On macOS, the Archive Utility.app is the default
application for extracting ﬁles from archives.
Double-click on the backup archive ﬁle (*.tar or *.tgz) in Finder to extract. The archive content will appear in
the folder where the archive is located. Then copy the ﬁles to the original location on the disk.
To convert a partitioned or encrypted archive to *.tar or *.tgz format, you have to use command line
applications. Then double-click on the archive in Finder. Examples of command lines can be found below. If
you are not familiar with shell applications, prefer using Get Backup.
Full Archive
You may have multiple archives created at diﬀerent times (we call them versions). Choose one of them (the
latest if you want to restore the most recent copies of your documents) and extract it. Older versions of Get
Backup also supported Versioned Archive type which can be treated in the same way as Full Archives.
Incremental Archive
You may have a series of incremental archives containing only those ﬁles that were modiﬁed after the
previous archive had been created. To restore all the ﬁles in the most recent versions, you should extract all
the archives to separate folders. The ﬁrst (oldest) archive must contain all the ﬁles included in the backup
project. Use the ﬁles and folders extracted from this archive as the basis. Move or copy the newest versions
of ﬁles there preserving the structure of included ﬁles and folders.

Examples of Command Lines
The openssl application is used for decryption. The cat application is used to concatenate parts of the
archive. The tar application is used for decompression. To enter command lines and run the applications
above, use the Terminal.app application located in the Applications/Utilities folder.
Remember that the elements of the command line should be separated with the "space" symbol. If a space
symbol is present in the ﬁle or folder name, or in the password, replace it with "\ " (slash and space) in the
command line. For example, use "document\ 1.txt" instead of "document 1.txt".
In command line examples below, parts you should change are underlined. Don't modify the rest.
To use a command:
1. Copy the command to a text editor (for instance, TextEdit.app).
2. Replace the sample path(s) to the actual ﬁle path(s). Replace the password if you have an encrypted
backup. Retain the spaces that separate the parts of the command line.
If a "space" symbol is present in the ﬁle or folder name, or in the password, replace it with "\ " (slash
and space) in the command line. For example, write "document\ 1.txt" instead of "document 1.txt".
3. Select the command line and copy it (Cmd-C).
4. Open the Terminal.app application located in the Applications/Utilities folder.
5. Paste the command (Cmd-V) and press the Return key to run.
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If you need to stop the process in Terminal.app urgently, press Ctrl-C.
Concatenate Parts
cat ~/path/vers20090701135457n.tar.aaa ~/path/vers20090701135457n.tar.aab >
~/path/backup.tar
Here:
~/path/vers20090701135457n.tar.aaa – the ﬁrst part;
~/path/vers20090701135457n.tar.aab – the second part (if you have more parts, put the path to each
separating them with the space symbol);
~/path/backup.tar – the output ﬁle path.
The input ﬁles (parts) must be present in the command line in the correct order: *.aaa then *.aab then *.aac
and so on.
Decrypt a Blowﬁsh Archive
openssl enc -in ~/path/vers20090701143400n.tar.bfe -bf -d -k password >
~/path/backup.tar
Here:
~/path/vers20090701143400n.tar.bfe – an archive encrypted using the Blowﬁsh algorithm (see the
ﬁle extension).
password – the password used to encrypt the archive.
~/path/backup.tar – the output ﬁle path.
Decrypt a Triple DES Archive
openssl enc -in ~/path/vers20090701151110n.tar.3des -des3 -d -k password >
~/path/backup.tar
Here:
~/path/vers20090701151110n.tar.3des – an archive encrypted using the Triple DES algorithm (see
the ﬁle extension).
password – the password used to encrypt the archive.
~/path/backup.tar – the output ﬁle path.
Decrypt a AES-128 Archive
openssl enc -in ~/path/vers20090701151110n.tar.aes128 -aes-128-cbc -d -k password
> ~/path/backup.tar
Here:
~/path/vers20090701151110n.tar.aes128 – an archive encrypted using the AES-128 algorithm (see
the ﬁle extension).
password – the password used to encrypt the archive.
~/path/backup.tar – the output ﬁle path.
Decrypt a AES-256 Archive
openssl enc -in ~/path/vers20090701151110n.tar.aes256 -aes-256-cbc -d -k password
> ~/path/backup.tar
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Here:
~/path/vers20090701151110n.tar.aes256 – an archive encrypted using the AES-256 algorithm (see
the ﬁle extension).
password – the password used to encrypt the archive.
~/path/backup.tar – the output ﬁle path.
Decrypt a AES-256 Archive and Extract Files
openssl enc -in ~/path/vers20090701153031n.tgz.aes256 -aes-256-cbc -d -k password
| tar -zxv -C ~/Desktop/backup/
Here:
~/path/vers20090701153031n.tgz.aes256 – a compressed archive encrypted using the AES-256
algorithm (see the ﬁle extension).
password – the password used to encrypt the archive.
~/Desktop/backup/ – the path to an existing folder where the extracted ﬁles will be written.
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Introduction to Disk Cloning
Disk cloning is one of many possible measures you can take to prevent data loss. Cloning duplicates the
contents of a particular volume. If the original disk is bootable, its clone can also bootable. This means that
you can back up not only your documents but also the operating system. The duplicate of your disk can be
used to boot your computer.
Cloning the APFS ﬁle system also aﬀects the hidden volumes: Preboot, Recovery and VM. Beginning from
macOS 10.15, system and user data are stored on separate volumes which together create a disk volume
group.
External drives such as HDD or SDD are the best media for a bootable disk clone.
The process of disk cloning takes quite a lot of time. Usually it isn't convenient to clone your disk frequently.
Subsequent runs of the disk cloning take less time because the program updates only the modiﬁed or
removed ﬁles. Planning your backup strategy, think about a combination of disk cloning with regular backups
(e.g. incremental or full) that include only user ﬁles. In such case, backing up can be more frequent (for
example, daily), and disk cloning less frequent (weekly or monthly).
If you plan to use your disk duplicate as an emergency working system, the disk for a clone should be of
suﬃcient capacity. It should be about 10% larger than all of your ﬁles take on the original disk.
It is recommended that you run the Disk Utility application to ﬁx possible ﬁle system problems. The tools that
allow you verify your disk are located in the First Aid tab. This application is in the Applications/Utilities folder.
The disk cloning tool erases everything on the destination volume. Make sure that there are no critical ﬁles on
it.
This documentation supposes that you create a system backup to be able to boot from it on the same
computer.
It is recommended that you boot from your emergency disk to make sure that a copy of your operating
system works well.
There are two ways to specify from what disk to boot your Mac. If your current operating system is running,
click the Apple menu and select System Preferences…. Choose a disk in the Startup Disk section. If you
cannot boot from the regular disk or your computer is turned oﬀ, press and hold the Alt (Option) key before
turning power on. Using this method, you can also boot from the Recovery volume if you need to use the
Disk Utility or other computer maintenance tool.
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Requirements for the Destination Volume
Disk cloning requires the APFS or Mac OS Extended (HFS+) ﬁle system. This ﬁle system has several
subversions such as Encrypted or Case-sensitive. It is recommended that the destination disk has the same
format as the source disk. Many disks and USB ﬂash drives have been formatted as FAT32. You can copy
ﬁles on these disks but cannot use as a start up disk until it is properly formatted.
Possibility to make a clone bootable depending on
volume formatting
Source
Mac OS Extended

Destination

Bootable

Mac OS Extended Yes
APFS

No

Mac OS Extended Yes
APFS
before macOS 10.15 APFS
Yes
APFS

Mac OS Extended No
APFS

Yes

The partition scheme should be GUID Partition Table (GPT).
The destination disk should be writable. If it has any write protection, deactivate it.
The Partitioning and Formatting your Disk section gives you an idea of how to prepare a disk for creation a
bootable copy of macOS.
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Partitioning and Formatting your Disk
Finding out the current partition map scheme
Finding out the current disk format
Partitioning your disk
Formatting your disk or volume
For all tasks described here, use the Disk Utility application located in the Applications/Utilities folder.
Finding out the current partition map scheme
Select your disk (not a volume) in Disk Utility. The partition map scheme is indicated in the table.

If the sidebar displays only volumes, select the View > Show all Devices in the main menu.
Finding out the current disk format
In Disk Utility, select a volume. Its format will be indicated right below the volume name in the upper section
of the main window.
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Also, you can click the Info button in the toolbar to get more details.

Partitioning your disk
Partitioning can erase all data on your disk. It is recommended that you backup your data before making any
changes.
To choose the partition map scheme, select the disk (not a volume) and click the Erase button. Choose GUID
Partition Map to make the disk bootable.
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To partition your disk, select it and click the Partition button. Then select how many partitions you need, and
specify the name, formatting and size for each of them.

Formatting your disk or volume
Formatting erases all data on your disk or a volume (depending on what is selected).
You can erase and format the whole disk. If there are several volumes, you can format them separately.
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To format a volume, select it. Click the Erase button in the toolbar and specify the volume name and
formatting. It is recommended that you choose the APFS disk format.
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The Disk Cloner Workspace
To open the disk cloning tools, click the third button in the main window or press Cmd-3.

1 – Select the destination disk where a copy of the source disk will be saved.
2 – Select the source disk that will be duplicated.
3 – The list of projects.
4 – The content of the source disk. To preview the content of a folder, click on the triangle next to its name.
5 – Add or delete a projects.
6 – The disk cloning project properties.
7 – An option to exclude items from the cloning process without deleting them from the backup project. If
you exclude a folder, all its content will be excluded too.
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Cloning a Disk
The disk cloning tool will delete all ﬁles on the destination volume if you clone to this disk for the ﬁrst time.
Deleting ﬁles can take some time. To save your time, you can erase the destination volume using the Disk
Utility application beforehand. There is no need to erase the destination disk when you clone to it the same
source disk again because most of ﬁles can be reused.
1. Select a volume you want to duplicate in the From drop-down list.
The volume must be formatted as APFS or Mac OS Extended and contain macOS installed if you want
your clone drive to be bootable.
2. Select a volume where the duplicate will be saved in the To drop-down list.
Make sure that there is enough space. Note that the existing content of the destination volume will be
erased. If the formatting of the destination is other than APFS or Mac OS Extended, you have to
change its formatting or choose another disk.
3. Set up the disk cloning properties.
4. Exclude ﬁles or folders if necessary. To do this, deselect check boxes next to the ﬁle or folder names. It
is not recommended to exclude anything outside your Home folder.
5. Click the Start button.
Notice that on macOS 10.15 and later, there are two commands for cloning in the main menu. The Start
Clean Cloning command should be used for the ﬁrst time (e.g., when you clone to an empty destination).
This command formats the destination volume and replicates your disk volume with help of the asr (Apple
Software Restore) utility.
The second command Start Cloning is used to update a previously created clone. On systems earlier than
macOS 10.15, this command is used for both the initial and repeated cloning.
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Restoring a Disk
Restoring from a clone is basically cloning in the opposite direction – from the backup to your original disk.
Being a copy of your original disk, the clone should be bootable.
To restore:
1. Boot from the clone. This should let you run Get Backup and Disk Utility.
2. Prepare the disk or volume you want to restore to (destination).
Make sure that you copied all ﬁles you want to keep to another storage because restoring will
remove everything from your destination disk volume.
Make sure that the destination disk is formatted to APFS (your clone must have APFS in this
case), or Mac OS Extended (Journaled). It is recommended that you format it now to ensure that
there is no errors in the ﬁle system.
3. Open Get Backup and close all other programs. Select the clone (volume from which you have booted)
as the source, and the prepared disk as the destination. Start the cloning process.
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The Disk Cloning Settings

The disk cloning tool lets you change the project name and color. Also, you can activate scheduled cloning
and set up its frequency.
The Show warning dialog when starting cloning option lets you skip displaying the warning message
before starting cloning. The message states that the content of the destination volume will be removed.
Select this check box to run scheduled cloning with no need of user's attention.
The USB source/destination automount option allows the program to mount a USB storage that is
currently connected but not mounted. Once the option is activated, the program will be able to mount the
USB device and run the scheduled task, unmount, and then mount it again for the next cycle.
Using the When source and destination are mounted option, you can allow the program to start cloning
automatically when the source and destination disks become available.
In order to have a scheduled project running fully automatically, it is recommended that you save your system
password to the Keychain. This can be done by using the Save admin access information in Keychain
option in the Preferences dialog.
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Explanations of Disk Cloner Messages
Messages in the disk cloning window instruct you or indicate the current state of the program. Below are
given explanations of them.
Select source and destination
– Suggests you select the source and destination volumes.
Clone will not be bootable (Source is not bootable)
– The volume clone will not be bootable because the original volume was not bootable.
Clone will not be bootable (Destination is not bootable)
– The volume clone will not be bootable because the ﬁle system or partitioning of the destination volume
does not comply with the requirements.
Clone may be bootable
– More likely the volume clone will be bootable.
Destination has insuﬃcient space
– The volume of the destination disk must be equal to or greater than the volume of the source disk.
Source and destination must diﬀer
– The same volume cannot be selected as the source and destination at the same time. Choose another
volume for either the source or destination.
Destination is read only
– The selected destination volume has hardware or software write protection. Deactivate the protection or
select other volume.
Source or destination is not accessible
– The program cannot access a previously selected volume. If you use an external or network volume, make
sure that it is connected. To verify that a volume is accessible, try to preview its contents in Finder.
Mac OS Extended or APFS required for source and destination
– The ﬁle system of the source or destination volume does not comply with the requirements.
Mac OS Extended (Case-sensitive, Journaled) recommended for destination
– Since the source volume has case-sensitive format, it is recommended that you format the destination
volume with the "case-sensitive" option.
Clone will not be bootable (unable to create bootable volume on the destination)
– The destination volume is APFS formatted while the source has Mac OS Extended formatting. To make the
destination volume bootable, it's formatting should be also Mac OS Extended.
Clone may be bootable (source is a Volume Group)
– The clone will be bootable.
Clone will not be bootable (APFS format is required on destination)
– The system volume should have the APFS ﬁle system for macOS 10.15 and higher.
Cloning Data Volume only
– Only APFS Data Volume will be copied because you are cloning an inactive system volume with macOS Big
Sur (version 11) or Monterey (version 12).

60

Introduction to File Synchronization
File synchronization is aimed to make copies of ﬁles in two folders identical.
File synchronization can be one-way or two-way. When you mirror ﬁles from one location in another, it is
called one-way synchronization. This happens when you copy new versions of ﬁles to a backup archive. Your
working folder is the source and the backup folder is the destination.
We talk about two-way synchronization, when one folder contains the newest version of one ﬁle and a
second folder contains the last version of another ﬁle. Both folders are the source and destination. You
should take into account that two-way synchronization in Get Backup is two one-way synchronizations
preformed one after another. Since that, if it makes diﬀerence for you which of the folders will be the source
ﬁrst, run one-way synchronization in one direction and then in the opposite one.
In the Synchronization Settings, you can allow to delete ﬁles and folders in the destination by deactivating the
Never delete anything option. Nevertheless, ﬁles that have the Locked property activated, cannot be
removed or replaced. To verify this property, right-click on a ﬁle in Finder and choose Get Info.
The synchronization tool also has an option to consider the ﬁle modiﬁcation date.
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The Synchronization Workspace
To open the synchronization tools, click the fourth button in the main window or press Cmd-4.

1 – Add or delete projects.
2 – Project properties.
3 – List of synchronization projects. Along with the project name, there is the date and time indicating when
you synchronized data the last time.
4 – An option to exclude items from the synchronization process. If you exclude a folder, all its content will be
excluded too. An excluded ﬁle or folder is treated as if it doesn't exist in the source.
5 and 7 – Lists of ﬁles and folders in the selected folders.
6 – The Analyze button compares the two selected folders. See The Meaning of Colored Signs and File
Names.
8 and 9 – Choose the folders you wish to compare and synchronize.
10 – The direction of the synchronization.
Left to right updates only the content of the right column. The left column is the source.
Right to left updates only the content of the left column. The right column is the source.
Bidirectional updates the content of both columns.
The Meaning of Colored Signs and File Names
The Analyze button compares the two selected folders and shows what the program will do if you run
synchronization. Icons in the middle of the list will indicate what kind of action will be taken. If a ﬁle is not
present in the source of destination, its name in the corresponding list is gray.
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Gray circle means that no action will be taken.
Green arrow indicates that the respective ﬁle will be copied from the source to the destination.
Red cross indicates that the respective ﬁle will be removed from the destination because it is not present in
the source. This is possible only if you deselect the Never delete anything check box in the project
properties.
Red cross next to the excluded ﬁle indicates that the respective ﬁle will be removed from the destination
because it was excluded. This is possible only if you deselect the Never delete anything check box in the
project properties.
Contour blue arrow indicates that the destination folder's properties (such as modiﬁcation date or colored
label) will be updated. The content of the destination folder will remain unchanged.
Blue triangle indicates that the content or properties of the destination folder will be updated. Some ﬁles or
folders of the destination can be updated or deleted.
Gray ﬁle name indicates that a ﬁle or folder is not present in one of the lists (source or destination) while it is
present in another.
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Synchronizing Files
In order to sync the contents of two folder:
1. Select two folders to be synchronized. To do this, click on a path box above the left and right columns.
2. Set up the synchronization direction by clicking on the arrow at the top. The arrow should point from
the source to the destination. By choosing the bidirectional arrow, you allow updating ﬁles in both
selected folders.
3. Click the Properties button and check the settings.
4. To ﬁnd out what the synchronization tool is about to do, click the Analyze button. Icons in the ﬁle list
will display if there are diﬀerent or missing ﬁles in the two locations, and how the program will deal with
this.
5. Click the Start button.
If your project includes ﬁles that are protected by the operating system (you may be unaware about that), you
will need to activate the Use administrator privileges check box in the project settings, and approve this
with admin's password in order to let the program access those ﬁle.
Instead of one or two folders, you can sync the contents of sparse bundle disk images. A disk image can
help you store ﬁles on a ﬁle system that is not compatible with Macs (e.g., network drive). This also allows
you to protect your ﬁles using an encrypted disk image. In order to create a disc image, select Process >
Create Disk Image… in the main menu. You can also create disk images, using the Disk Utility application.
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The Synchronization Settings

1 - The color of the tag in the project list. This can help you highlight projects by importance or by other
principle.
2 - The project name. It is displayed in the main window. Note that projects with identical names are not
allowed.
3 - Run the program with the administrator privileges. To activate this option, you will have to input the
administrator's password.
4 - Exclude ﬁles. While comparing and synchronizing the content of two folders, the program can disregard
ﬁles of the speciﬁed type. You can also create a custom pattern to exclude ﬁles.
5 - The option to sync or ignore the extended attributes. Files on your Mac may have extended attributes that
are not supported by the destination ﬁle system. In this case, you can tell the program to ignore them to
avoid error messages in the log.
6 - The Consider modiﬁcation date option is needed for the situation when the destination folder contains a
newer version of a ﬁle than the source folder. Select this check box if you don't want to overwrite the newer
version.
7 - This option prevents the deletion of ﬁles in the destination folder if they are not found in the source folder.
Be careful, with this option!
8 - An option to mount network drives automatically. This option can be disabled if the remote or external
drive is (or can be) physically disconnected (e.g. a USB drive). To check the ability to mount the network
drive, unmount it in the Finder and click the Mount button here.
9 - Activate the automatic backup creation when the source and destination volumes are mounted.
10 - Automate ﬁle synchronization according to the time schedule.
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Exclude Files by Pattern
A folder added to your project may contain some ﬁles which you don't want to back up. The Exclude tool can
help you automatically exclude such ﬁles.
You can choose a predeﬁned ﬁle type or create your own pattern. To do this, activate the By pattern option
and select a ﬁle you want to exclude. For example, if you select a report.txt ﬁle and choose the "the same
extension" option, all .txt ﬁles will be excluded.
A pattern can contain a ﬁle name or extension, or both. Several patterns can be combined to create a
complex rule.
To add a pattern:
1. Click the Select button.
2. Select one of radio buttons:
• the same extension to exclude all ﬁles of the same type as the sample ﬁle has (the part of the full ﬁle
name after the most right period.
• the same name to exclude all ﬁles with the same name as the sample ﬁle has (the part of the full ﬁle
name before the most right period).
• the same name and extension to exclude all ﬁles with the same name and extension as the sample
ﬁle.
3. Choose a sample ﬁle to use its name or extension as a pattern.
4. To join the current pattern with the existing one, select the Combine with previous pattern check
box. This way you can exclude several ﬁle types from the archive. If you deselect the check box, a new
pattern will replace the existing one.
5. Click Capture.
You can create a pattern manually by typing it into the edit box. You should follow these rules:
All patterns consist of three elements: ﬁle name, period (.), and extension.
Use the asterisk symbol (*) instead of the ﬁle name or extension to indicate a ﬁle with any name or any
extension. Example: *.jpeg means "any ﬁle in the JPEG format".
Don't add any extra symbols (quotation marks, spaces, commas, etc.) unless they are a part of the ﬁle
name or extension.
Use the | symbol (so called pipe) to separate several patterns.
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Starting a Task by a Schedule
The program can start a backup, cloning or synchronization process automatically with a certain period of
time. You can set up each project's schedule individually in the project Properties dialog.

In order to scheduled tasks be performed automatically, you should activate the schedule agent in the
Preferences dialog. As soon as you activate the schedule of any project, the program will remind you to
activate the schedule agent. When the time to start a scheduled project comes, the agent opens the
program.
When you are setting up the schedule, take into account that it is better to choose time when you computer
is less loaded by the user or other autonomously running software.
Notice that the program can also run a task when you mount the destination or source volume. This takes
place in the case a scheduled task couldn't be performed because the source or destination or both volumes
were unavailable. Once both locations are reachable, the program will start tasks without waiting for the
following scheduled time.
The Repeat attempts if unable to run the scheduled task option deﬁnes how to deal with situations when
it is not possible to complete the task at the scheduled time. For example, an external drive might not be
connected to the computer. If the option is activated, the app will try to run the task again when the
conditions to ﬁnish the task are good. This may happen anytime before the next scheduled time. When the
option is deactivated, the program will try to run your project within 10 minutes starting from the scheduled
time. Then it stops its attempts until the next scheduled time.
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Starting a Task When a Disk is Mounted
The destination or source disk of any of your projects can be an external disk such as an USB drive. You can
tell the program to start a corresponding task automatically when its source and destination disks is
mounted. In other words, when you connect a USB stick, which is set as the destination, your ﬁles will be
automatically copied to it. You can activate this feature in the project Properties dialog by selecting the When
source and destination are mounted check box.
Note that mounting other types of disks like local or network ones cannot start automatic tasks.
In order to have your task be performed automatically when the program is not open, you should activate the
schedule agent in the Preferences dialog. As soon as you turn on the auto start of any project, the program
will remind you to activate the schedule agent.
It is possible that you activate the When source and destination are mounted check box together with the
schedule in the same project. In this case, starting a task by the schedule will be primary. As long as the task
is performed by the schedule successfully, plugging in the source or destination disk between the scheduled
times will not run the task. Only if a task was ﬁnished unsuccessfully at the last time, the program will run it
again when you connect the corresponding external disk.
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Suspending Scheduled Tasks
You can suspend starting scheduled tasks when the regular time is not appropriate for some reason. For
example, you can be in the process of editing some document, and want to get the document backed up
when it is ﬁnished.
Suspending tasks for a speciﬁed period of time guarantees that the scheduler will be activated automatically.
If you deactivate the scheduler manually, you risk forgetting to activate it again.
The Suspend Scheduler button in the bottom right corner of the main window indicates the scheduler
mode. Normally, its icon shows a clock.

In the suspended mode, the icon shows an exclamation mark. The same applies to the menu bar icon.

To suspend all scheduled tasks, click the Suspend Scheduler button. Then select how long the scheduler
should stay deactivated.
Alternatively, you can click on the menu bar icon of Get Backup, choose Suspend Scheduler… and specify
for how long this state should last.

The program resumes the scheduler automatically unless you have selected the "unlimited time" option. In
this case, you should stop the suspended mode manually.
To exit the suspended mode, click the Suspend Scheduler button.
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